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RESUMO 

O clima regional afeta diretamente municípios que não possuem um efetivo plano de ação, por exemplo, de 

ocorrência de inundações, como apresenta a Bacia Hidrográfica do Rio Tijucas, Biguaçu e Contíguas. Portanto, 

é de suma importância identificar e propor adaptações para os riscos presentes às populações da bacia. Para 

identificar o gatilho que causa este fenômeno, que são eventos de precipitação extrema, é necessário entender o 

clima regional, a fim de quantificar a taxa de eventos hidrológicos críticos de acordo com os valores médios e 

máximos, aspectos da intensidade, duração e frequência, a sua sazonalidade, além de características 

morfológicas e físicas da bacia. Avaliando estes aspectos no presente estudo, foi possível mensurar a 

caracterização da bacia hidrográfica para a ocorrência de inundações por meio de levantamentos de dados atuais, 

possibilitando a consideração de parâmetros mais realísticos para obras de infraestrutura junto às escarpas e 

áreas de proteção permanente, bem como na zona rural e urbana. Ou seja, identificou-se aspectos cruciais para 

a ocorrência do desastre hidrológico relativo à inundação e obteve-se a equação e curva de intensidade, duração 

e frequência com os dados pluviométricos de precipitação distribuídos na região hidrográfica, que apresentaram 

parâmetros distintos na área da bacia. 

 

PALAVRAS-CHAVE: Dados ambientais, inundação, caracterização.  

 

 

1. INTRODUÇÃO 

O Painel Intergovernamental sobre Mudanças Climáticas (do inglês IPCC), menciona que as consequências das 

mudanças climáticas advêm de atividades antrópicas intensificadas no último século. Mesmo com o 

desenvolvimento social e tecnológico, ainda há retrocesso no uso consciente e sustentável dos recursos naturais 

(SHUKLA et al., 2022). É necessário mitigar as mudanças climáticas para inibir as ameaças a todos os 

ecossistemas, pois, desta forma será possível atingir os Objetivos de Desenvolvimento Sustentável (ODS) 

proposto pela Organização das Nações Unidas (ONU).  

 

O aumento do número de dias com fortes chuvas provocando os eventos extremos de precipitação em algumas 

regiões pode ser proveniente das mudanças climáticas. A elevação da temperatura e a umidade do ar são fatores 

essenciais para a formação das chuvas, mas associando com a variabilidade climática é possível observar este 

fenômeno ocasionando enchentes, deslizamentos de terra e perdas de vida (NOBRE et al., 2010). A relação da 

precipitação extrema com as mudanças climáticas resulta em inúmeros transtornos ambientais, sociais e 

econômicos, fato este perceptível em diversas bacias hidrográficas do Estado catarinense.  
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De acordo com Lei Estadual nº 10.949 de 1998, que dispõe sobre a caracterização do Estado de Santa Catarina 

em dez regiões hidrográficas, devendo promover a gestão descentralizada dos recursos hídricos, adotando-se as 

bacias hidrográficas como unidades de gestão e realizando o planejamento regional voltado para o 

desenvolvimento sustentável, buscando garantir a água em qualidade e quantidade satisfatórias para as gerações 

atuais e futuras (ALESC, 1998).  

 

Conforme (SIRHESC, 2022), a Bacia Hidrográfica do Rio Tijucas está inserida na Região Hidrográfica 8 (RH 

8) - Litoral Centro, a qual possui área de drenagem de aproximadamente 2.371 km², com montante no município 

de Rancho Queimado e jusante em Tijucas, contando com 15 (quinze) municípios ordenados politicamente, 

atualmente denominado de Comitê de Bacias Hidrográficas do Rio Tijucas, Biguaçu e Bacias Contíguas.   

 

A precipitação extrema tem afetado tanto a agricultura quanto a população da Bacia Hidrográfica do Rio Tijucas. 

Conforme (GONÇALVES, 2003), os impactos mais comuns são enchentes, deslizamentos, doenças, prejuízos 

aos patrimônios familiar, comercial e público. A Defesa Civil municipal e estadual emite alertas antecedendo a 

chegada dos fenômenos meteorológicos e orienta a população em situações emergenciais como vendavais, 

deslizamentos, inundações, raios e tempestades, geada, granizo e tornados. O risco é a relação entre a 

probabilidade da ameaça ou acidente acontecer, sendo atribuído a um grau de vulnerabilidade decorrente dos 

seus efeitos. Portanto, é necessário identificar a ameaça para que seja possível prevenir a ocorrência de acidentes 

(DCSC, 2022).  

 

Fica evidente a necessidade da projeção de cenários de riscos para a região do Rio Tijucas que sofre com 

precipitações extremas e suas consequências. Ressalta-se que a mais recente foi no ano de 2022. Sendo que o 

município mais afetado do Vale do Rio Tijucas foi o município de São João Batista. Este episódio ocorreu entre 

01 a 05 de dezembro de 2022, atingindo a cota máxima emergencial do Rio Tijucas. O alto índice pluviométrico 

foi fator primordial no ocasionamento de inundações graduais na região do município de São João Batista - SC. 

O temporal com pancadas de chuvas pontualmente intensas que persistiu por 2 (duas) semanas, atingindo a 

margem de 85% da população municipal. Além da população, indústrias, animais, pontes, dentre outros aspectos 

foram impactados pela precipitação extrema. Portanto, através do Governo Federal foi decretado situação de 

calamidade pública através da Portaria do Ministério do Desenvolvimento Regional nº 3.485 (SANTA 

CATARINA, 2022).  

 

Dessa forma, o presente estudo busca investigar e identificar os pontos suscetíveis a inundações na Bacia 

Hidrográfica do Rio Tijucas, Biguaçu e Bacias Contíguas e elaborar planos de ações para atenuar os impactos 

que ocorrem na região. A Figura 1 retrata um período cronológico de inundações na bacia. 

 

Figura 1 - Levantamento histórico de registros fotográficos de desastres relativos a inundações na bacia: 

ordem cronológica. 

 
Fonte: Elaboração própria (2023) a partir das informações da SDE e municípios da bacia. 
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2. OBJETIVO GERAL 

Caracterizar a bacia hidrográfica do Rio Tijucas, Biguaçu e Contíguas e a precipitação associada a eventos 

extremos. 

 

 

2.1. OBJETIVOS ESPECÍFICOS 

a) Mapear as características regionais da Bacia Hidrográfica do Rio Tijucas, Biguaçu e Contíguas;  

b) Aplicar os métodos estatísticos de estudos da intensidade, duração e frequência da precipitação associada a 

eventos extremos climáticos que impactam nos fenômenos de inundação. 

 

3. METODOLOGIA 

A metodologia aborda dois eixos: bases climáticas e ambientais e o tratamento de dados. A mesma contém 4 

(quatro) etapas (Figura 2). 

 

Figura 2 – Metodologia Aplicada. 

 
Fonte: Elaboração própria (2023). 

 

 

3.1. DADOS DE PRECIPITAÇÃO 

Para a obtenção de dados de precipitação, foram utilizados a partir do produto MERGE desenvolvido por 

Rozante et al. (2010) e disponibilizado pelo Centro de Previsão de Tempo e Estudos Climáticos (CPTEC), o 

qual combina os dados de precipitação observada com a precipitação estimada por satélite (ROZANTE et al., 

2010). As séries de precipitação são atualizadas diariamente, possuindo uma base de dados desde junho de 2000 

até o presente. Para fins de análise histórica de precipitação, foi utilizado o período disponível correspondente 

aos anos de 2001 a 2020 (20 anos). A partir desses dados foi possível avaliar o regime de precipitação na região 

e estipular os anos de precipitação extrema anual. 

 

Conforme detalhado por ROZANTE et al. (2010), o uso do satélite Tropical Rainfall Measuring Mission 

(TRMM) fornece produtos através da combinação de diferentes sensores de estimativas de precipitação. o 

satélite TRMM é utilizado devido a disponibilização de dados em tempo real, no qual utiliza-se da Técnica 

Barnes (BARNES, 1964), desenvolvida por Stanley L. Barnes em 1964, onde é interpolado os dados de postos 

pluviométricos observados para o ponto de grades com resolução de 0,1º a 0,1º de latitude e longitude 

(aproximadamente 10 km). Para uma análise abrangente, selecionou-se três municípios internos à bacia para a 

análise do regime de precipitação, sendo eles: Rancho Queimado (Montante), Tijucas (Jusante) e São João 

Batista (central).  

 

Para a extração dos dados para estas coordenadas, utilizou-se o Grid Analysis and Display System (GrADS) para 

a manipulação dos mesmos. Esta ferramenta é utilizada para a manipulação de dados podendo ler arquivos de 

formato binário (fluxo ou sequencial), GRIB (versões 1 e 2), NetCDF, HDF (versões 4 e 5) e BUFR (para dados 

de estação) (COLA, 2023). Para a manipulação e extração dos dados, foram utilizados algoritmos a fim de 

selecionar os dados da região de estudo, obtidos em forma de texto (txt). 
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3.2. CARACTERIZAÇÃO DA ÁREA DE ESTUDO 

A Bacia Hidrográfica do Rio Tijucas, objeto de estudo, situa-se na Macrorregião Hidrográfica do Atlântico Sul, 

no Sistema de drenagem da vertente Atlântica e na Região Hidrográfica 8 – Litoral Centro, na qual está sob as 

coordenadas GMS longitude (E) 49°19’43” e 48°27’42” e latitude (S) 27°46’36” e 27°02’35” e UTM longitude 

(E) 664686.04 e 751793.88 e latitude (S) 6926417.38 e 7006258.98. Atualmente os municípios de Angelina, 

Antônio Carlos, Biguaçu, Bombinhas, Canelinha, Governador Celso Ramos, Itapema, Leoberto Leal, Major 

Gercino, Nova Trento, Porto Belo, Rancho Queimado, São João Batista, São José e Tijucas integram o Comitê 

Tijucas, Biguaçu e Bacias Contíguas, possuindo 5 (cinco) nascentes dos cursos d’água principais em toda a sua 

extensão. A partir do Software de Geoprocessamento e Sensoriamento Remoto ArcGIS versão 10.5. em 

consonância com base cartográfica georreferenciados provindos de órgãos das esferas municipais, estaduais e 

federais, foi possível delimitar a bacia hidrográfica. O Shapefile da delimitação da Bacia Hidrográfica foi cedido 

pela Defesa Civil de Santa Catarina, o qual foi elaborado pela Companhia de Pesquisa de Recursos Minerais 

(CPRM) e Secretaria de Estado do Desenvolvimento Econômico Sustentável (SDE). Já os dados de Hidrografia 

foram extraídos da plataforma da Agência Nacional das Águas e a malha municipal está disponibilizada na 

plataforma do IBGE (Figura 3).  

 

Figura 3 – Delimitação da bacia hidrográfica do Rio Tijucas, Biguaçu e Contíguas. 

 
Fonte: Elaboração própria a partir de dados da ANA (2012), IBGE (2022) e DCSC (2022). 

 

O Instituto de Pesquisa Econômica Aplicada (IPEA), cita a relação do uso do solo com episódios de inundações. 

O crescimento acelerado da urbanização influencia no aumento da taxa de áreas impermeáveis impedindo a 

infiltração da água pluvial, afetando o regime hídrico contribuindo com o aumento do volume de escoamento 

superficial, incidindo na ocorrência de desastres hidrológicos provocando fenômenos que estão associados às 

enchentes como os alagamentos, inundações e enxurradas (IPEA, 2021). 

 

Os impactos que mais influenciam na bacia, sendo a mais recorrente a ocupação irregular em áreas de proteção 

permanente, seguido com o descarte de resíduos no leito do rio, uso de agrotóxico por conta das lavouras, a 

extração mineral (argila) devido às atividades ceramistas e tráfico de animais (MEURER, 2011).  

 

Para a construção do mapa de uso do solo na bacia hidrográfica, foram utilizados dados do Mapa de Cobertura 

Florestal e Uso da Terra de Santa Catarina disponibilizado pelo IFFSC (2023) e elaborado por Vibrans et al. 

(2010). Utilizou-se o software ArcGIS para a elaboração do mapa, e como a base cartográfica está para a escala 

estadual, foi necessário dimensionar para a escala da bacia, portanto utilizou-se a ferramenta geoprocessing > 

clip. Como o arquivo estava no formato WGS necessitou realizar a conversão para UTM através da ferramenta 

ArcToolbox > Data Management Tools > Projections and Transformations > Project. Após isso, para obter 

uma melhor visualização dos dados espacialmente é necessário organizar a tabela de atributos através das 
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Properties > Symbology > Categories > Unique Values > Value Field (uso terra). O dado Value Field analisa 

o dado da tabela de atributos que será demonstrado espacialmente, como a finalidade é demonstrar a distribuição 

do uso do solo na bacia, escolheu este atributo para a visualização. Desta forma, é possível analisar a extensão 

do uso do solo e o tamanho da área que abrange.  

 

Já para os dados geológicos, geotécnicos e pedológicos foram utilizados base cartográfica da CPRM e Empresa 

Brasileira de Pesquisa Agropecuária (EMBRAPA) disponibilizado na plataforma dos mesmos. Portanto, para a 

obtenção de mapas de geologia, hidrogeologia e pedologia utilizou-se ferramentas do ArcGIS para delimitar os 

dados para a bacia em questão. É necessário adequar a coordenada geográfica de WGS para UTM e após utilizar 

a ferramenta clip para “recortar” a bacia dos dados de Santa Catarina. Através destes atributos é possível 

demonstrar os dados espacialmente com a ferramenta Symbology.  

 

Para a elaboração do mapa de declividade, utilizou-se os dados disponíveis na plataforma da EPAGRI-CIRAM. 

Na plataforma estão disponíveis os modelos digitais de terreno - MDE (do inglês DEM – Digital Elevation 

Model) que são dados produzidos pela Shuttle Radar Topography Misson - SRTM, projeto criado pela National 

Aeronautics and Space Administration - NASA em parceria com a agência de inteligência geoespacial - NGA 

(EPAGRI, 2022). 

 

De acordo com a EPAGRI (2022), o MDE do estado de Santa Catarina possui: “Resolução espacial de 30 metros, 

em formato Geotif e GRID 16 bits, e que abrange a área entre as coordenadas 54º 03’ 30” w, 29º 28’ 40” s e 48º 

09’ 45” w e 25º 39’ 15” s. O MDE está dividido segundo as regiões hidrográficas do estado e apresenta uma 

sobreposição (buffer) de 2Km entre elas”. 

 

Na plataforma da EPAGRI-CIRAM, os MDE estão classificados de acordo com a região hidrográfica, portanto, 

como a bacia hidrográfica se encontra interna a RH-8, foi utilizado este dado no formato Tagged Image File 

Format - TIFF. 

 

Inicialmente foi adicionado o formato TIFF no arquivo MDE no software ArcGis 10.5, no qual, foi necessário 

converter o sistema de projeção do arquivo MDE de WGS para UTM através da ferramenta ArcToolbox > Data 

Management Tools > Projections and Transformations > Raster > Project Raster. 

 

Após a projeção, foi realizado o recorte da bacia no MDE com os seguintes passos: ArcToolbox > Spatial Analyst 

Tools > Extraction > Extract by Mask. Seguinte a projeção e delimitação, foi realizada a ferramenta slope para 

a obtenção da declividade através da ferramenta ArcToolbox > Spatial Analyst Tools > Surface > Slope 

utilizando a forma de percentil para a obtenção dos dados e equiparar com as classes de relevo definidos pela 

Embrapa conforme demonstra a Tabela 1. 

 

Tabela 1 – Classificação da Declividade. 

Classe de Relevo Declividade (%) 

Plano 0 – 3 

Suave Ondulado 3 – 8 

Ondulado 8 – 20 

Forte Ondulado 20 – 45 

Montanhoso 45 – 75 

Escarpado > 75 

Fonte: Elaboração própria a partir de dados de SDE (2017). 

 

 

3.3. CARACTERIZAÇÃO MORFOLÓGICA 

O Sistema de drenagem fluvial pode ser classificado quanto a sua ordem, densidade de drenagem, razão de 

bifurcação e comprimento dos rios. O ordenamento dos fluxos é classificado de acordo com sua ramificação. O 

córrego de ordem 1 não recebe contribuição de outros afluentes. Já o córrego de 2ª ordem recebe o afluente 

apenas de 1ª ordem. O córrego de 3ª ordem, recebe carga dos afluentes de 1ª e 2ª ou 2ª ordem. O córrego que 

obtiver a maior contribuição de afluentes, ou seja, o curso d’água com a maior hierarquia é considerado como o 

rio principal e caracteriza a ordem de drenagem da bacia hidrográfica (HORTON, 1945). 



 

6 

AESABESP - Associação dos Engenheiros da Sabesp 

Conforme STRAHLER (1952), os córregos que não possuem nenhum tributário desde a nascente são 

denominados como rios de primeira ordem. Quando houver a confluência de dois córregos de primeira ordem, 

surge o rio de segunda ordem, sendo que este recebe apenas efluente dos rios de primeira ordem. Os canais de 

terceira ordem, recebem tributários de rios de segunda e primeira ordem, e assim ocorre com canais de ordem 

superiores. 

 

Para realizar hierarquia fluvial da Bacia Hidrográfica do Rio Tijucas, Biguaçu e Contíguas, utilizou-se MDE 

para a aplicação do Método Strahler através do software de geoprocessamento ArcGIS com o intuito de verificar 

a ordem da drenagem do trecho e correlaciona-lo com o regime de vazão. Para regularizar as imperfeições dos 

dados utilizou-se a ferramenta Spation Analyst Tools > Hydrology > Fill. Após isso, realizou o método para 

determinar a direção do fluxo na bacia através da ferramenta Spation Analyst Tools > Hydrology > Flow 

Direction. Obtendo a direção do fluxo, utiliza-se a ferramenta Flow Accumulation para gerar os valores de fluxo 

acumulado através da ferramenta Spation Analyst Tools > Hydrology > Flow Accumulation. A fim de corrigir 

problemas na elaboração e excluir valores negativos que não são significativos utiliza-se a ferramenta Con 

encontrado na Spation Analyst Tools > Conditional > Con, ressalta-se que quando solicitar um Value na aba 

Expression deve-se introduzir o valor 1.000, fato este necessário pela bacia ser de pequeno porte. Após a 

realização de todas estas etapas é possível aplicar o método Strahler através da ferramenta Spation Analyst Tools 

> Hydrology > Stream Order que irá ordenar o curso d'água estudado. 

 

BERTONI & TUCCI, (2001), relata a importância do cálculo da área através de software de Sistema de 

Informação Geográfica (SIG) para a definição do potencial hídrico da bacia. É possível associar a área calculada 

com a taxa de precipitação, para obter o volume de água recebido pela bacia hidrográfica. A partir da bacia 

hidrográfica delimitada utilizou-se a ferramenta Calculate Geometry disponibilizada na tabela de atributos do 

dado no software ArcMap 10.5 para obtenção da área e perímetro. Após criar um shape apenas do rio principal, 

utilizou-se da mesma ferramenta para estabelecer o seu comprimento. 

 

Segundo STUDART et al., (2006) a largura média de uma bacia é obtida pela divisão da área da bacia pelo 

comprimento da mesma. Considera-se o comprimento do trecho mais longo de montante e foz (equação 1). 

 

𝐿𝑚 =  
𝐴

𝐿
                                                                                                                                                 equação 1 

 
Onde:  

Lm = Largura média da bacia [km]; 

A = Área da bacia [km²]; 

L = Comprimento do curso mais extenso da bacia [km]. 

O valor da largura média da bacia hidrográfica está apresentado a seguir: 

 

É necessário reconhecer a forma de uma bacia hidrográfica para analisar o seu comportamento hidrológico. 

Bacias hidrográficas com forma circular tendem a ocorrer maiores episódios de enchentes, pois, o percurso do 

runoff se torna mais curto tendendo a concentrar água em diversos pontos ocasionando em uma maior vazão. Já 

em bacias com o perfil alongado, há um percurso maior até o exutório, pois, há uma maior distribuição de chuva 

ao longo de sua extensão apresentando uma menor vazão de pico (VILLELA; MATTOS, 1975). 

 

Segundo (STUDART et al., 2006), este índice indica a maior ou menor tendência para enchentes de uma bacia: 

“Uma bacia com Kf baixo terá menor propensão a enchentes. Isto se deve ao fato de, numa bacia estreita e longa 

(Kf baixo), haver menor possibilidade de ocorrência de chuvas intensas cobrindo simultaneamente toda sua 

extensão”. 

 

Para calcular o fator de forma, é necessário obter a largura média através da razão da área pelo comprimento do 

curso principal. Após obter a largura média, deve-se dividir o valor pelo comprimento do maior curso d’água 

para obter o fator de forma (STUDART et al., 2006). Portanto, poderá ser calculado através da equação 2. 

 

𝐾f =
𝐴

𝐿²
                                                                                                                                                   equação 2 

 

A tabela 2 relaciona o valor obtido através do fator de forma da bacia com sua característica.  
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Tabela 2 – Classificação da bacia através do valor do fator de forma. 

Kf Característica da Bacia 

1,00 – 0,75 Bacia com alta propensão de grandes enchentes 

0,75 – 0,50 Bacia com tendência mediana a grandes enchentes 

< 0,75 Bacia não sujeira grandes enchentes 

Fonte: Elaboração própria a partir de dados de STUDART et al., (2006), VILELLA; MATTOS (1975). 

 

Conforme VILLELA; MATTOS (1975), é possível relacionar bacia com fatores de forma para identificar o 

tempo de escoamento da água até o exutório. GRAVELIUS (1914), explana que o índice de compacidade é a 

relação entre o perímetro da bacia com o de uma forma geométrica, sendo que o valor varia conforme a forma 

da bacia, e quando o Kc se iguala a 1 consiste em relatar que a bacia é perfeitamente circular, influenciando sua 

relação com os episódios de inundações. O Kc pode ser encontrado através da equação 3. 

 

𝐾𝑐 = 0,28 ∗
𝑃

√𝐴
                                                                                                                                   equação 3 

 

Onde: 

Kc= Coeficiente de Compacidade; 

P= Perímetro (km); 

A= Área da bacia (km²). 

 

A tabela 3 relaciona o valor do coeficiente de compacidade com a característica da bacia, classificando-a como 

circular, quadrada, retangular ou comprida: 

 

Tabela 3 – Classificação da bacia através do coeficiente de forma. 

Kc Característica da Bacia 

Kc = 1 Bacia é perfeitamente circular 

Kc = 1,128 Bacia é quadrada 

Kc = 1,4 Bacia é retangular 

Kc > 3 Bacia é comprida 

Fonte: Elaboração própria a partir de dados de GRAVELIUS (1914), VILELLA; MATTOS (1975). 

 

CHRISTOFOLETTI (1979), cita que bacias com densidade de drenagem inferior a 7,5 são de baixa capacidade 

de drenagem, isto incide sobre a taxa de infiltração da bacia, classificando como boa ou ruim. Conforme 

CARELLI & LOPES (2011), a densidade de drenagem depende tanto das características físicas e climáticas da 

bacia. A partir da Equação 4, a densidade de drenagem pode ser calculada: 

 

𝐷𝑑 =
𝐿𝑡

𝐴
                                                                                                                                                      equação 4 

 

Onde Lt é o comprimento total dos canais. 

 

Segundo VILLELA; MATTOS (1975), se o índice de densidade de drenagem for conforme a tabela abaixo 

relacionando o valor da densidade de drenagem com a característica da bacia, é possível classificá-la conforme 

a eficiência de drenagem da bacia: 

 

Tabela 4 – Densidade de drenagem da bacia. 

Dd Característica da Bacia 

Dd < 0,5 km/km² Bacias com drenagem pobre 

Dd entre 0,5 e 3,0 km/km² Bacias mediamente drenadas 

Dd maior que 3,0 km/km² Bacias ricamente drenagem 

Fonte: Elaboração própria a partir de dados de CHRISTOFOLETTI (1979), CARRELI &LOPES (2011). 
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De acordo com GUIMARÃES (2017), o relevo médio da bacia é realizado através da curva hipsométrica, pois, 

através da plotagem é possível identificar a variabilidade das altitudes dos terrenos da bacia hidrográfica. 

 

A variação do relevo pode ser indicada de acordo com as curvas de nível, salientando a porcentagem da área de 

drenagem com a altimetria (VILLELA; MATTOS, 1975).  

 

Para a obtenção dos dados de área e cotas foi necessário o uso do software ArcGis 10.5. Inicialmente insere-se 

o arquivo MDE no software ArcGIS e projetar a sua projeção cartográfica de WGS para UTM. A fim de delimitar 

a área, utiliza-se o comando extract by mask para o “recorte” da delimitação da bacia hidrográfica no MDE. O 

comando utilizado para a obtenção das curvas de níveis através da contagem de pixels do MDE de acordo com 

a cota do terreno é Spatial Analyst Tools > Reclass > Reclassify, através deste comando foram divididas em 12 

classes através da subtração da cota maior pela menor e dividido por 100 metros de intervalo. Ao efetuar os 12 

intervalos, foi possível a extração dos dados do ArcGis para o manuseio no Excel através do comando Spatial 

Analyst Tools > Zonal > Zonal Statistics as Table (DELGADO, 2022). Conforme VILLELA; MATTOS (1975), 

a elevação média da bacia pode ser calculada através da equação 5. 

 

𝐸 = ∑𝑒 ∗
𝑎

𝐴𝑡𝑜𝑡𝑎𝑙
                                                                                                                                          equação 5 

   

Onde: 

E = Elevação média da bacia 

e = Elevação média entre duas curvas de nível 

a = Área entre as curvas de nível 

Atotal = Área total 

 

Para chegar até a fórmula da elevação média da bacia foi necessário realizar cálculos para obter os parâmetros 

específicos. É necessário criar uma planilha para a realização dos cálculos conforme demonstrada na Tabela 5. 

 

Tabela 5 – Escopo da planilha para elaboração da curva hipsométrica. 

0 1 2 3 4 5 6 7 

Intervalo Cota Cota 

média 

Área 

(km²) 

Área acumulada 

(km²) 

Área 

% 

Área 

Acumulada (%) 

Cota média (km²) 

* Área (km²) 

Fonte: Elaboração própria (2023). 

 

As colunas 0, 1 e 3 já estão tabeladas por serem extraídas do software ArcGIS, no entanto, foi necessária a 

conversão da área de m² para km². A coluna 2 representada pela cota média, seria a média entre a cota a jusante 

e a montante. Já com relação a coluna 4, é calculado a área acumulada que está ao longo do perfil altimétrico. 

O primeiro valor repete igual ao da coluna 3 pois seria o ponto inicial, e logo após nas próximas células, é 

somado a área anterior (coluna 4) com a área posterior (coluna). O total de área (km²) deverá ser igual ao total 

de área acumulada (km²). Na coluna 5 representa a porcentagem por cada área dos trechos altimétricos. O cálculo 

é realizado através da equação 6: 

 

Á𝑟𝑒𝑎 (%) = Á𝑟𝑒𝑎 (𝑘𝑚) ∗
100

𝐴𝑡𝑜𝑡𝑎𝑙 ²
                                                                                                           equação 6 

 

A área acumulada (%) representada pela coluna 6 é expressa através do somatório da área (%) anterior com a 

área (%) posterior, sendo que o primeiro valor é repetido igual ao da área (%). Para introduzir os dados na 

equação, é necessário fazer a multiplicação da cota média com a área expressa em km². Ou seja, a coluna 2 com 

a coluna 3. Após o preenchimento de toda a tabela é possível calcular a elevação média da bacia hidrográfica de 

estudo. O cálculo da elevação mediana da bacia é expresso através da seguinte equação: 

 

𝐴𝐸 (𝑚𝑒𝑑) = 0,5 ∗ 𝐴𝑡𝑜𝑡𝑎𝑙                                                                                                                        equação 7 

 

Onde: 

AE (med) = Elevação mediana 

Atotal = Área total 
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Após efetuar o cálculo, é necessário identificar os extremos de cota e área para a realização da interpolação e 

encontrar a elevação mediana da bacia através da equação a seguir. 

 

𝐸𝑚𝑒𝑑 = 𝐸2 + (𝐸1 − 𝐸2) ∗
𝐴𝑡𝑜𝑡𝑎𝑙

2
−𝐴2

𝐴1−𝐴2
                                                                                                      equação 8 

 

Após efetuar os cálculos, é possível traçar a curva hipsométrica e obter os dados de Elevação Média e Mediana. 

 

 

3.4. INTENSIDADE, DURAÇÃO E FREQUÊNCIA 

Para abordar as equações do regime de chuvas intensas, é necessário conhecer o valor da vazão máxima e 

associá-la ao período de retorno. No entanto, a obtenção de séries históricas de dados de vazão e de pluviômetros 

são escassos, sendo necessário a utilização da modelagem hidrológica para a transformação do índice chuva-

vazão através da relação da duração-intensidade-frequência (IDF) (DAMÉ et al., 2014). 

 

Para fins de estudo da bacia hidrográfica será realizado a atualização dos dados dos parâmetros da equação IDF 

para comparar a região hidrográfica com os dados já tabelados pela metodologia (DENARDIN; FREITAS, 

1982). Para isto, faz-se necessário a utilização do método proposto pela CETESB através da distribuição de 

Gumbel. A fim de traçar parâmetros para a área de estudo, três municípios representando a montante, jusante e 

ponto médio da bacia hidrográfica foram escolhidos para a realização dos cálculos de IDF. A elaboração da 

curva IDF consistiu em utilizar os dados anuais de precipitação intensa obtidos através do GrADS e IDLE, no 

período de 20 anos. Os municípios escolhidos foram Rancho Queimado (-27,6791 e -49,0074), São João Batista 

(-27,2766 e -48,85) e Tijucas (-27,2405 e -48,6344). 

 

De acordo com NOBRE et al. (2021), a distribuição de Gumbel utiliza da probabilidade, uma ferramenta para 

prever a precipitação máxima. Conforme CETESB (1980), as séries de precipitações devem ser dispostas de 

forma decrescente, associando os dados com o período de retorno e a probabilidade de ocorrência. Para os dados 

de entrada de precipitação, foram calculados a soma, média e o desvio padrão da série de dados. Através da 

equação 9 criada por Ven Te Chow (Fórmula Weibull) e a equação 10 para séries anuais através do método de 

probabilidade de Gumbel/log-probabilístico, é possível mensurar tais dados. 

 

𝑝 =
𝑚

𝑛+1
                                                                                                                                                    equação 9 

 

𝑇 =
1

𝑝
 𝑜𝑢 =

𝑛+1

𝑚
                                                                                                                                       equação 10 

 

Onde: 

p = Probabilidade acumulada de um evento ser igual ou superior 

m = Número de ordem 

n = Número de anos de registro considerado 

T = Tempo de recorrência (anos) 

 

Após definido o Tempo de Retorno (T), substitui-se a variável na distribuição de Gumbel através da equação 

11. 

 

𝑦 = − 𝑙𝑛 𝑙𝑛 [ −𝑙𝑛 (1 −
1

𝑇
)]                                                                                                                     equação 11  

 

Calculado o y, é realizada a média das variáveis para poder obter o desvio padrão da série de Gumbel, através 

da equação: 

 

𝑆𝑦 = (𝑦 − 𝑦𝑚𝑒𝑑)²                                                                                                                                equação 12 

 

Onde: 

Sy = Desvio padrão da distribuição 

y = Variável reduzida da distribuição - obtido através da fórmula anterior 

ymed = Média das variáveis reduzidas da distribuição 
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A equação 13 explana a obtenção do parâmetro k, no qual, foram utilizados os dados referentes às variáveis 

reduzidas de Gumbel. 

 

𝑘 =
𝑦−𝑦𝑚𝑒𝑑

𝑆𝑦
                                                                                                                                             equação 13 

 

Onde: 

k = Parâmetro 

y = Variável reduzida da distribuição 

ymed = Média das variáveis reduzidas da distribuição 

Sy = Desvio padrão da distribuição 

 

Efetuado os cálculos, é possível obter a precipitação para cada tempo de retorno (t). Deste modo, através da 

média e desvio padrão das entradas (x) e do método de distribuição de Gumbel (y), é possível calcular a variável 

reduzida (yt) com relação ao período de retorno definido para os anos de 2, 5, 10, 25, 50 e 100 anos através da 

seguinte expressão: 

 

𝑦𝑡 = −𝑙𝑛 − 𝑙𝑛 [1 − (
𝑡−1

𝑡
)]                                                                                                                      equação 14 

 

Onde: 

yt = Variável reduzida 

ln = Logarítmo natural 

t = Período de retorno (2, 5, 10, 25, 50 e 100 anos) 

 

Obtido a variável reduzida em relação ao período de retorno, calculou-se a variável K para encontrar os valores 

de precipitação através da equação 15. 

 

𝐾 =
𝑦𝑡−𝑦𝑚𝑒𝑑

𝑆𝑦
                                                                                                                                            equação 15 

 

Onde: 

K = Parâmetro 

yt = Variável reduzida 

ymed = Média das variáveis reduzidas da distribuição 

Sy = Desvio padrão da variável reduzida da distribuição 

 

Desta forma é calculada a precipitação diária para os períodos de retorno definidos, através da seguinte 

expressão: 

 

𝑃 = 𝑋𝑚𝑒𝑑 + 𝐾 ∗ 𝑆𝑥                                                                                                                               equação 16 

 

Onde: 

P = Precipitação média diária 

Xmed = Média da precipitação de entrada 

K = Parâmetro - obtido através da fórmula anterior 

Sx = Desvio padrão amostral da precipitação de entrada 

 

O método de desagregação de chuva é utilizado para locais onde não possui dados de pluviógrafos, oferecendo 

resultados de precipitação com duração inferior a um dia (CETESB, 1980). Conforme PEREIRA et al., (2017), 

para realizar o método de desagregação é necessário utilizar as seguintes durações 5, 10, 15, 20, 25, 30, 60, 120, 

180, 360, 480, 600, 720 e 1440 minutos o qual corresponde a 5 min, 10 min, 15 min, 20 min, 25 min, 30 min, 1 

hora, 2 horas, 4 horas, 6 horas, 8 horas, 10 horas, 12 horas e 24 horas. Para a chuva de 1 dia, utilizou-se os 

valores da precipitação média diária, pois, neste período corresponde aos horários de observação pluviométrica 

(TUCCI, 2001). Para obter a precipitação de 24 horas, é multiplicado o coeficiente de desagregação referente a 

devida duração pela precipitação de 1 dia. Já as precipitações horárias, é necessário multiplicar o coeficiente de 

desagregação de cada duração pela precipitação de 24 horas. Para as durações em minutos, multiplicou-se o 

coeficiente de cada duração pela precipitação de 1 hora. Após obter os dados de desagregação, é aplicado aos 
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dados o suplemento do Microsoft Excel, Solver, o qual realiza o Método dos Mínimos Quadrados a fim de ajustar 

a série de dados, minimizando a soma dos erros dos quadrados entre o valor estimado e os dados observados. 

 

 

4. RESULTADOS OBTIDOS 

O estado de Santa Catarina está localizado na zona subtropical, no qual é influenciada de forma latitudinal pela 

transição entre os trópicos e subtrópicos, longitudinal pelo Oceano Atlântico e pela altitude norteado pelo 

Planalto das Araucárias e as Serras Catarinenses (CAVALCANTI et al., 2009). IPA (1989) e PANDOLFO et 

al., (2000), enfatizam a importância do conhecimento das variáveis climáticas para a avaliação do clima da 

região estudada. Desta forma, é possível identificar a dinâmica climática local e planejar as atividades a serem 

desempenhadas, como é o caso da agricultura, silvicultura e pecuária. 

 

A variabilidade climática ocorre pelo deslocamento de massas de ar (quente e fria) e os sistemas frontais 

(ciclones, frentes frias e frentes quentes). As correntes marítimas que fazem a circulação dos ventos, tendem a 

influenciar o clima regional interferindo nos fatores de vento, temperatura e precipitação na zona costeira 

(CAVALCANTI et al., 2009). 

 

A Classificação de Köppen relaciona os tipos de clima com os tipos de vegetação. Segundo a classificação de 

KÖPPEN, Santa Catarina é classificado como clima mesotérmico úmido (Cfb), ou seja, sem estação de seca. 

Este tipo climático possui dois subtipos, o Clima Subtropical (Cfa) que apresenta no mês mais frio uma 

temperatura média de 18°C, e no mês mais quente, uma temperatura média de 22°C, tendo verões quentes com 

concentrações de chuvas, e poucas geadas, assim não possuindo uma estação seca definida; já o Cfb apresenta 

no mês mais frio, temperatura média de 18°C, e possui verões frescos, com temperatura média menor que 22°C, 

sem estação seca definida (PANDOLFO et al., 2000). 

 

Conforme o Plano Estadual de Recursos Hídricos (2017), a Região Hidrográfica Litoral Centro apresenta uma 

variação de temperatura média anual do ar de 19,5 ºC a 12,5 °C (SDE, 2017). 

 

De acordo com (PANDOLFO et al., 2000), a RH8 é descrita pelo clima subtropical mesotérmico úmido com 

verões quentes (Cfa) e subtropical mesotérmico úmido com verões amenos (Cfb). A classificação Cfa é 

mensurada por temperaturas maiores que 10º C (inverno) e maiores que 22º C (verão). Já o Cfb que não possui 

verão intenso, as temperaturas médias tornam-se menores que 22º C no mês que possui a maior alteração da 

temperatura (Tabela 6). 

 

Tabela 6 – Classificação climática da RH-8 – Área (% da área total da bacia ou região). 

Bacia Hidrográfica Cfa Cfb 

Rio Biguaçu 47,90 52,10 

Rio Cubatão do Sul 45,39 54,61 

Rio da Madre 74,37 25,63 

Rio Tijucas 44,28 55,72 

RH8 59,45 40,55 

Fonte: Elaboração própria a partir de dados de PANDOLFO et al., (2000) apud SDE (2017). 

 

A precipitação total anual da Região Hidrográfica 8, varia entre 1.400 mm e 2.200 mm. A Bacia Hidrográfica 

do Rio Tijucas é um local propício a inundações. É possível notar na Tabela 7 que a Bacia do Rio Tijucas 

apresentou a maior ocorrência de eventos de inundação que ocorrem pelas chuvas prolongadas, onde as secas, 

que é caracterizada pela estiagem prolongada, são menos frequentes. Estes dados foram levantados entre os anos 

de 2003 e 2015 (SDE, 2017). 
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Tabela 7 – Eventos de inundação no período de 2003 e 2015. 

Bacia Hidrográfica Secas Inundações 

Rio Biguaçu 1 10 

Rio Cubatão do Sul 1 13 

Rio da Madre 0 2 

Rio Tijucas 3 41 

RH8 6 91 

Fonte: Elaboração própria a partir de dados de SDE (2017). 

 

Conforme o Plano Estadual de Recursos Hídricos de Santa Catarina (2017), a bacia hidrográfica do Rio Tijucas 

é a mais suscetível em ocorrer eventos de inundação: “Analisando os eventos de inundação por bacia 

hidrográfica, nota-se que a Bacia do Rio Tijucas é mais propensa à ocorrência deste tipo de evento, apresentando 

a ocorrência de 41 eventos entre 2003 e 2015, seguido pelas bacias contíguas, com 25 eventos registrados no 

período”. 

 

Analisando os eventos de inundação por bacia hidrográfica, nota-se que a Bacia do Rio Tijucas é mais propensa 

à ocorrência deste tipo de evento, apresentando a ocorrência de 41 eventos entre 2003 e 2015, seguido pelas 

bacias contíguas, com 25 eventos registrados no período (SDE, 2017). Estes dados são importantes para 

identificar os períodos e locais onde houveram mais episódios de inundações dentro da região hidrográfica, 

sendo este, um subsídio no levantamento das áreas suscetíveis a inundação. 

 
A fim de identificar a hierarquia fluvial da Bacia Hidrográfica do Rio Tijucas, Biguaçu e Contíguas (Figura 4), 

utilizou-se o MDE para aplicar o método de Strahler, através do Sistema de Geoprocessamento ArcGIS. 

 
Figura 4 – Hierarquia fluvial da bacia pelo método Strahler. 

 
Fonte: Elaboração própria a partir de dados da EPAGRI/NASA (2005) e DCSC (2022). 

 

O mapeamento de uso e ocupação do solo da bacia mostra uma extensão de formação florestal, no entanto, no 

percurso do rio principal (Rio Tijucas), nota-se a vasta presença de áreas edificadas e antropizadas nas margens 

do rio (Figura 5). Além disso, os dados de geologia, hidrogeologia, pedologia e declividade foram levantados 

através da plataforma de geoprocessamento e dimensionado para a bacia hidrográfica de estudo. 
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 Figura 5 – Caracterização da Área de Estudo. 

 

 

                                       
Fonte: Elaboração própria a partir de dados de EMBRAPA (2018), CPRM (2022), IFFSC (2017), IBGE (2022), 

ANA (2012). 
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A partir da bacia hidrográfica delimitada utilizou-se a ferramenta Calculate Geometry do software ArcGIS para 

obtenção da área e perímetro. Após criar um novo shape apenas do rio principal, utilizou-se da mesma ferramenta 

para estabelecer seu comprimento. O Quadro 1, explana os dados da bacia após o uso da ferramenta Calculate 

Geometry. 

 

Quadro 1 – Dados de Extensão da Bacia Hidrográfica. 

Dado Símbolo Extensão  

Área da Bacia (A) 3.280 km² 

Perímetro da Bacia (P) 736 km² 

Comprimento do Talvegue (L) 97,91 km² 

Fonte: Elaboração própria (2023). 

 

Com relação à caracterização da morfologia, foi realizado os cálculos para identificar a forma da bacia e 

relacioná-la com a possibilidade de ocorrência de inundação. Conforme os resultados preliminares, foi 

averiguado que de acordo com os parâmetros morfológicos, a bacia possui formado comprida, sendo 

medianamente drenada e não está sujeita a grandes enchentes (Quadro 2). Portanto, é necessário investigar as 

demais características da bacia e a climatologia regional, bem como o próprio método usualmente utilizado para 

essa determinação para a apuração do que mais influencia na ocorrência de inundações. 

 

Quadro 2 – Aspectos Morfológicos da Bacia. 

Nº FÓRMULA MÉTODO CÁLCULO RESULTADO CONCLUSÃO 

(1) 
 

Largura Média da 

Bacia (Lm)  
 

 - 

(2) 
f  

Fator de forma 

(Kf) 
 

 
 

Kf < 0,50 = Bacia não 

sujeita grandes 

enchentes 

(3) 
 

Índice de 

Compacidade de 

Gravelius (Kc) 
 

 
 

Kc > 3 Bacia 

comprida. 

(4) 
 

Densidade de 

Drenagem (Dd) 

 

 
 

 

Dd entre 0,5 e 3,0 

km/km²= Bacias 

mediamente drenada 

Fonte: Elaboração própria a partir de dados de GRAVELIUS (1914), VILLELA E MATTOS, (1975), 

CRISTOFOLETTI, (1980), STUDART (2006). 

 

Investigou-se o perfil da curva hipsométrica, o qual os dados foram extraídos a partir do ArcGIS através da 

ferramenta reclass, onde a bacia foi segregada por intervalos de área a fim de identificar o relevo da área, 

conseguinte, foi possível expor os dados em uma planilha para gerar a curva hipsométrica e posteriormente 

mapear a região. O Quadro 3 demonstra a planilha de dados criada a partir das fórmulas mencionadas 

anteriormente para a plotagem da curva hipsométrica. 
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Quadro 3 – Dados para a curva hipsométrica. 

 
Fonte: Elaboração própria (2023). 

 

A partir dos dados de hipsometria gerados no software ArcGIS demonstrados anteriormente no Quadro 3, foi 

possível gerar a curva hipsométrica. E a partir da curva, foi possível realizar o mapa da hipsometria para a análise 

das cotas da região hidrográfica 

 

Figura 6 – Curva e mapa hipsométrico. 

 
Fonte: Elaboração própria (2023). 

 

Com intuito de utilizar os dados de precipitação do produto MERGE e atualizar dados de IDF para a região 

hidrográfica, foi realizado o método de Gumbel para a criação de novas curva IDF para a região, selecionado 

três municípios da bacia, uma na montante (Rancho Queimado), outra no ponto médio da bacia (São João 

Batista) e por fim na jusante da bacia (Tijucas). Ressalta-se que os tempos de retorno utilizados foram de 2, 5, 

10, 25, 50 e 100 anos. 

 

Tabela 8 – Parâmetros IDF. 

Parâmetros  Rancho Queimado São João Batista Tijucas 

K 602,07 688,91 852,72 

m 0,19 0,18 0,21 

b 9,92 9,93 9,92 

n 0,73 0,73 0,73 

Fonte: Elaboração própria (2023). 
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Figura 7 – Plotagem da curva IDF. 

 
Fonte: Elaboração própria (2023). 

 

 

5. ANÁLISE E DISCUSSÃO DOS RESULTADOS 

Ao realizar o ordenamento do rio através do método Strahler pode-se notar que a bacia hidrográfica em estudo 

é de 5ª ordem, tendo como rios principais (em vermelho), os rios Tijucas e Biguaçu. 

 

Com relação à caracterização da morfologia, realizou-se os cálculos para identificar a forma da bacia e relacioná-

la com a possibilidade de ocorrência de inundação. Conforme os resultados preliminares, foi averiguado que de 

acordo com os parâmetros morfológicos, a bacia possui formado comprida, sendo medianamente drenada e não 

está sujeita a grandes enchentes. Portanto, é necessário investigar as demais características da bacia e a 

climatologia regional, para a apuração dos dados que mais influenciam na ocorrência de inundações. 

 

A partir dos dados de precipitação, gerou-se a curva e o mapa de hipsometria. Analisando os dados obtidos pode-

se perceber de forma harmonizada que a altitude máxima da bacia é de 1.238 metros, a altitude mínima é de 0 

m (nível do mar), a altitude média é de 810 metros e a mediana é de 835 metros 

 

Através da metodologia aplicada a curva IDF é possível transformar os dados da chuva diária em chuva intensa 

de menores durações sendo possível a identificação do tempo de concentração na bacia e o tempo de retorno. O 

tempo de retorno significa a ocorrência da precipitação em anos. Analisando os parâmetros de Tijucas em relação 

aos dois municípios, nota-se que o parâmetro K e a intensidade da chuva são superiores aos outros. 
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6. CONCLUSÕES 

Analisando a área de estudo, é possível identificar que a forma da bacia não é a causa raiz para a ocorrência de 

inundações na região. Portanto é necessário identificar os demais aspectos, como a precipitação, pedologia, 

hipsometria e uso e ocupação do solo.  

 

A caracterização física da bacia foi realizada através do software ArcGIS 10.5 com intuito identificar aspectos, 

elementos e fatores ambientais da bacia. Com relação aos rios principais, a bacia possui quatro, sendo eles: Rio 

Tijucas, Rio Biguaçu, Rio das Antas e Rio Alto Braço, no qual estão distribuídos em quinze municípios 

integrantes.  

 

A bacia possui aspecto ondulado, no qual corresponde a locais com declividade entre 8% e 20%, com média de 

12% e máximo de 64%. 

 

Visualizando o mapa de uso e ocupação do solo foi averiguado a crescente intervenção antrópica nas margens 

do Rio Tijucas, impactando a mata ciliar. 

 

Com relação às características biológicas, a bacia hidrográfica possui predominância de Floresta Ombrófila 

Densa (FOD), onde há uma grande contribuição da pluviometria impedindo que haja períodos biologicamente 

secos. 

 

Já o enquadramento de Köppen da Bacia Hidrográfica de estudo está incluído tanto em Cfa quanto Cfb, no 

entanto, maior parte da bacia se enquadra em clima subtropical mesotérmico úmido com verões quentes (Cfa). 

 

A pedologia característica na bacia é norteada por Cambissolo Haplico e Argissolo Vermelho-Amarelo, os quais 

são moderadamente drenados e com argila na sua composição. Dependendo do relevo do local, a pedologia se 

torna fator importante para delimitações de áreas suscetíveis à inundação. 

 

Realizou-se a hierarquização da ordem dos rios através do método de Strahler, no qual pode-se observar que a 

bacia hidrográfica possui aspectos de quinta ordem, ou seja, rios que se formam com a união de rios de quarta 

ordem. 

 

Através dos cálculos de Fator de Forma (Kf), Densidade de Drenagem (Dd) e Índice de Compacidade (Kc) pode-

se constatar o aspecto de uma bacia comprida, medianamente drenada e com Kf menor que 0,5, ou seja, a forma 

da bacia do rio Tijucas não está sujeita a grandes enchentes. 

 

Com relação a hipsometria da bacia, pode-se notar que a altitude máxima da bacia é de 1.238 metros, a mínima 

a nível do mar, a altitude média é de 810 metros (mediana igual a 835 metros). O relevo dentro da bacia é variado 

contribuindo na variabilidade climática, pois, o mesmo determina a circulação das massas de ar. Observou-se 

que a bacia representa relevo acentuado por estar localizada entre a elevação da serra catarinense e a planície 

costeira, embora o relevo mais acentuado do estado não se encontre dentro da bacia. 

 

A realização da curva de intensidade, duração e frequência com os dados pluviométricos obtidos do produto de 

precipitação MERGE foram relevantes para a análise do comportamento de precipitação na região hidrográfica, 

sendo que a equação da chuva foi distinta para os locais investigados dentro da própria bacia. Além disso, a 

atualização de dados de IDF para os locais selecionados, possibilitando a consideração de parâmetros mais 

realísticos para obras de infraestrutura junto às escarpas e áreas de proteção permanente, bem como na zona 

rural e urbana. 

 

Assim, sugere-se que novos estudos considerem o clima presente e futuro nos dados de precipitação disponíveis 

para antecipar e mitigar os impactos ambientais de eventos de inundação que hoje já são temerosos para a 

população na bacia. 
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